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Introducing	  SWAMI	  XP2	  
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Dr. Peter D'Adamo was getting frustrated. 
 
 
The renowned author of a series of wildly successful nutrition books, including the New York Times 
bestseller Eat Right For Your Type, Dr. D'Adamo was beginning to see the limitations of the 
traditional static book format when it came to developing his brand of highly personalized diets. 
Now, books are OK when it comes to one-size-fits-all diets and even individualized diets based on 
single genes, like blood type. You just turn to one of the four chapters that describes your particular 
type and away you go. But what happens when we try to incorporate 5, 10 or even 20 different 
genetic markers? How could he ever capture biochemical individuality inherent in each of us with 
such an inflexible format?  
 
Computers to the Rescue.  
 
Fortunately, Dr. D'Adamo has had a life-long interest in computer programming and it soon became 
apparent that his beloved hobby could provide the answer: Why not write a computer program that 
allowed each individual to develop their own one-of-a-kind diet? So four years ago, Dr. D'Adamo 
began to write computer code. Lots of it. What resulted is undoubtedly the most sophisticated, yet 
easy-to-use, dietary software available. First it was only available to physicians, who've used it on 
thousands of their patients. Now it is available directly to health-conscious consumers. A series of 
electronically generated diet and recipe books that magically write themselves. He called it SWAMI.  
 
Why SWAMI?  
 
The word SWAMI stands for 'Serotyping With Advanced Modifying Inventories.' Serotyping is the 
process of using blood groups to generate dietary recommendations. 'Advanced Modifying 
Inventories' are all the extra things (fingerprint analysis, measurements, etc.) that are used to refine 
the Blood Type data into the GenoType Diet. No, there is nothing mystical in the program's name, 
nor is there a little wizard inside your computer figuring out your diet... or is there?  
 
Want to Know More?  
 
SWAMI XP2 features an easy-to-use, well-structured user interface, web-based, so you are always 
using the latest version of the software without the hassle of installation. Downloadable user guide 
and online help with information screens make getting your information into SWAMI XP2 a snap.   
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Rich and Simple. 
 
 
Imagine walking into your local bookstore, picking up a popular diet book, and watching it 
miraculously write itself for you in front of your very eyes! That's the power of SWAMI XP2. Unlike 
static, unchangeable, one-size-fits-all diet books, SWAMI XP2 will use your own health profile to 
build a dynamic, unique book that is right for your biochemical individuality. 
 
SWAMI XP2 features an attractive, well-structured user interface. Web-based, so you are always 
using the latest version of the software. Extensive help and information screens make getting your 
data into SWAMI XP2 a snap. 
 
You tell It, It tells You. 
 
Incorporating blood types, biometric measurements and fingerprint data SWAMI XP2 allows you to 
add an astounding amount of new detail to your dietary recommendations and supplies you with an 
incredibly detailed, reader friendly and versatile report. Swami XP2 enables you to generate an 
estimated 50-page personalized dietary report out of your printer after 12,600,000 individual 
calculations performed on 225 individual nutrient values found for each of 800 different foods, all 
matched to the results of your measurements and intake facts. 
 
However, that is not the end of SWAMI's capabilities. 
 
Do you keep a Kosher kitchen? Lean towards a more Paleo lifestyle? You can alert SWAMi to your 
specific preferences and it will adjust its results to try and accommodate them. You can also tweak 
SWAMI in specific support directions, such as healthy nervous system function or better hormonal 
balance. 
 
Nutrient Filters and Genoharmonics. 
 
The Nutrient Filter, a special feature long supported in the professional version of SWAMI, has just 
been introduced in SWAMI XP. This handy device allows you to select certain nutrients that can be 
emphasized and de-emphasized in your diet. Need to increase foods with a beneficial ration of 
omega-3 fatty acids? No problem. Restrict gluten-containing foods? No problem. 
 
Geno-Harmonic food relationships emphasize combinations of superbeneficial foods contain 
nutrients that enhance the overall epigenetic health of the body. Because maintaining gene fidelity is a 
major hallmark of healthy aging, using these food combinations will have maximium personalized 
health-enhancing effects in your body. 
 
Infinitely Expandable. 
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SWAMI XP2 is designed to grow as your horizons expand. Do you have information on your 
ancestral DNA haplogroups? New lab results? No problem! Although not required, SWAMI XP2 can 
incorporate these data, and more! 
 

Because a diet is more than just choosing foods. 
 
 
If SWAMI XP2 did nothing besides generate state-of-the-art nutrigenomic diets it would still be a 
landmark piece of nutritional software. But Dr. D'Adamo teaches and maintains a full clinical 
practice, so he knew from the start that simply giving his patients information about whether a 
certain food was good or bad would not be enough for many people. Most of us need a context in 
which to follow a diet: What to cook and how to meal-plan. This type of information is often critical 
to maintaining the program long enough to allow for the results to set in. 
 
As an added bonus, SWAMI XP2 come bundled with a complete weekly Meal Planning Module and a 
Cook Book Generator that can call upon a universe of over 2000 recipes that are prescreened for 
your needs. there is also a unique Cross-Referencer that allows you to list and compare multiple 
diets! 
 
SWAMI Weekly Mealplanner 
 
So Dr. D'Adamo made sure that SWAMI XP2 included a series of extras, including a full featured 
drag-and-drop Weekly Mealplanner. In adition to allowing you to plan your weekly meals, the 
Mealplanner will generate any of the recipes you select for printout and even provide you with a 
shopping list for all the necessary ingredients! 
 
Recipe/ Cookbook Creator 
 
The SWAMI Recipe Generator that can call upon over 7000 recipes to find those best suited for 
each individual. You can select any number of recipes, or allow SWAMi to select the 100 highest 
rated receipes based on the results of your diet report. 
 
Cross-Reference Diets 
 
It is inevitable that family members will have slight or even significant differences in their diet reports. 
A new feature of SWAMI XP2 allows multiple diet reports to be linked to a single account. SWAMI 
can then combine these diets into a cross-referenced list to help with meal planning 
 
Extensive Help Screens 
 
And because he also knows that many people need help navigating through computer screens and 
menus, he included a variety of help screen, tutorial videos, online technical help and web 
communities to insure your continued success. 
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 Getting Started  
 
Once you have purchased your SWAMI XP2 license, you will receive an account number, user name 
and password. 
 
SWAMI XP2 is web-based, which has the advantage of guaranteeing that you are always using the 
most recent implementation. Using SWAMI XP2 is as easy as doing any other function in your 
internet browser but formatting was worked out for the Mozilla “Firefox” browser.  SWAMI XP2 
also works well in Safari, Google Chrome and in most versions of Internet Explorer. 
 
You can download Firefox from here: 
 
http://www.mozilla.com/en-US/firefox/ 
 
You can download Chrome from here: 
 
https://www.google.com/chrome 
 
Anyway, type or copy this URL to you browser and we’ll get started. 
 
http://www.swamiXP2 .com 
 
You should see the following welcome screen: 
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SWAMI XP2 employs a tabbed navigation system. As you move through the program the options 
presented in these tabs will change.  If you look at the top of the screen you will see two of these 
folder tabs. The active tab is always at the front and tabs that lead to other areas of the program 
recede a bit towards the back. Most screens in SWAMI XP2 feature HELP tabs. These offer quick 
and simple assistance to help you get around the program. These usually open up in a small window 
on top of your current screen. 
 
This is the LOGIN SCREEN, and it is typically where you will begin using SWAMI XP2 . However, 
before we jump into the program, let’s make sure that everything is set properly on your computer 
and Internet browser.  
 
Click on the tab labeled Swami Support. This link will take you to the SWAMI XP2 customer 
support area. 
 
 

 
 

 
 
 
This screen contains some helpful information about the state of your browser. In order for SWAMI 
XP2 to work correctly, you must have two critical settings on your browser properly set. 
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SWAMI Status Report 

Cookie	  Status	  
 
SWAMI XP2 uses cookies to keep track of your information as you move from screen to screen. 
These will need to be enabled on your browser for SWAMI XP2 to work properly.  A cookie is a 
small bit of data that keeps track of your purchases as you move from page to page. If cookies are 
not enabled on your browser, the program has no way of remembering who you are and what data 
you’ve entered. 
 
Solution: 
 
The Help portion of the toolbar on most browsers will tell you how to set your browser to accept 
new cookies, how to have the browser notify you when you receive a new cookie, or how to disable 
cookies altogether. Additionally, you can modify the settings for similar data used by browser add-
ons, such as Flash cookies, by changing the add-on's settings or visiting the website of its 
manufacture. 

JavaScript	  Status	  
 
JavaScript is a web programming language that enhances the function of the browser. SWAMI XP2  
uses JavaScript extensively for most of its intake forms and HELP screen pop-up windows.  
 
Cause: 
 
You may have JavaScript disabled on your browser. This website uses JavaScript (a computer 
language) to communicate with your browser. 
 
Solution: 
 
Below are instructions for enabling JavaScript for browsers we support. 
 
Macintosh Mozilla browser 
 

• From the browser, select the Mozilla menu and select Preferences 
• Click the arrow next to Advanced 
• Click Scripts & Plug-ins 
• Click to check Navigator, beneath Enable JavaScript for 
• Click OK 
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Macintosh Firefox browser 
 

• From the browser, select the Firefox menu and select Preferences 
• Depending on your browser version, select the Web Features icon in the left column or 

select the Content icon in the top row 
• Click to check Enable JavaScript 
• Click OK 

 
Windows or Linux Mozilla browser 
 

• From the browser, select the Edit menu and select Preferences 
• Click the arrow next to Advanced 
• Click Scripts & Plug-ins 
• Click to check Navigator, beneath Enable JavaScript for 
• Click OK 

 
Windows or Linux Firefox browser 
 

• From the browser, select the Tools menu and select Options 
• Depending on your browser version, select the Web Features icon in the left column or 

select the Content icon in the top row 
• Click to check Enable JavaScript 
• Click OK 

 
Windows Internet Explorer 5.x  6.x 7.x browser 
 

• From the browser, select the Tools menu and select Internet Options 
• Select the Security tab 
• Click the Custom Level button at the bottom. The Security Settings dialog box will pop up 
• Scroll down to the Scripting category and enable Active Scripting, Allow paste operations via 

script and Scripting of Java applets 
• Click OK on the Security Settings dialog box, then on the Internet Options dialog box 
• Click YES in response to any confirmation question 
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Browser	  Status	  
 
The SYSTEM STATUS screen also provides some interesting information on what browser you are 
using, which operating system you computer is running, etc. This information can be helpful if you 
are working out a problem with Technical Support and they need to know the environment that 
SWAMI is running on locally on your machine. 
 
OK, we’ve insured that your computer meets the basic requirements for running SWAMI XP2. Let’s 
move onto the LOGIN SCREEN and get going. Click the Log In tab to login.  
 
Account Number, User Name and Password 
 
Please enter these values into the proper fields.  Press the Log Into SWAMI XP2 Button and you 
are good to go. 
 
 

Purchasing a SWAMI Account 

	  	  
In order to log in to SWAMI XP2, you must first purchase a User Account. This is easily 
accomplished via the secure online SWAMI e-store. To access the E-store, click the Learn More 
About SWAMI XP2 tab at the top of the log in screen. 
 
 

 
  
 
This will open up the SWAMI introduction screens. Click on the last tab, labeled Purchase 
SWAMI.  
 

  
 
Follow the directions through the four screens. If your information is correct and your credit card 
information is approved, you will be taken to the Manage Your Account dashboard. You will also 
receive an email continuing your log in information for future use. 
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SWAMI XP2  Intake Data Screen with help pop-up 
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II.	  

Managing	  Your	  SWAMI	  Account	  
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If log in was successful, you will be taken the first basic screen of SWAMI XP2, the Manage Your 
Account screen. This screen contains your personal information and is always available. You can 
edit this information as needed. Once you’ve entered your account details, press the Edit 
Information button to save your account. You will then to this screen with your new account data 
added to the form.  
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How SWAMI XP2 Accounts Work  
 
The Manage Your Account screen is essentially your SWAMI dashboard for controlling any of the diet 
intakes that are linked to your account. You access these from the four lower tabs. Manage Your 
Account brings you back to the account details page. The others allow you to select and work on 
your diet intakes. 
 
 

 
 
 
 

Manage Your Diet Intakes 
 
The Manage Your Diet Intakes screen allows you to see at a glance all the diet intakes linked to your 
account. Clicking on the Last Name (blue hyperlink) will load that intake into the editor. This screen 
also provides access to the SWAMI Cross-Reference function.  
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SWAMI Cross-Referencer 
 
It is inevitable that family members will have slight or even significant differences in their diet reports. 
This new feature of SWAMI XP2 allows multiple diet reports to be linked to a single account. 
SWAMI can then combine these diets into a cross-referenced list to help with meal planning. The 
SWAMI Cross-Referencer allows you to merge individual diets so you can see their food values at a 
glance.  
 
Only a fully completed diet intake is available for cross-referencing. If available you will see a 
checkbox in the right most column. Ticking that checkbox will include that result in the cross-
reference. A maximum of three diets can be cross-referenced at any on time.  Pressing the Cross-
Reference Selected Diets button will result n SWAMI providing a listing of the cross-reference food 
values. 
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IV.	  

SWAMI	  XP2	  Intake	  Data	  Screen	  
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SWAMI Diet Intake 
 
The Intake Data Screen is the heart of SWAMI XP2 . It is the ‘control tower’ that allows you to set 
the parameters which will eventually go on to become your diet protocol. It is also the most 
complex part of the program. Take your time and work through this section slowly and carefully. 
You will then be rewarded with the ability to use SWAMI XP2 to its full capacity. 
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Getting Around 
 
Although it might seem a bit daunting at first, the SWAMI XP2 Intake Data Screen is very 
straightforward and elegant in its design. You typically move through the form from the top down to 
the bottom. At the bottom is the SUBMIT button which converts your intake data into a Diet 
Report.  
 
Since we will be adding intake data for the first time, notice that the tab advises you to ADD YOUR 
INFORMATION. Later on, when you return to SWAMI XP2 to alter your intake data (perhaps with 
new information) this tab will instead say EDIT YOUR INFORMATION. 

Welcome 
 
SWAMI XP2 will usually welcome you to the program by name. Its salutation (“Good Morning’, 
“Good Evening”) is relative to Eastern Standard Time. The green ‘power button’ tells you that 
everything is in order and SWAMI XP2 is ready for your input.  If a problem arises this button will 
change to amber to alert you of the problem and how to correct it. 

Jump Table 
 
SWAMI XP2 is organized into sections labeled 1-C.  You can use the JUMP TABLE at the top of the 
screen to move around quickly without having to scroll down.   
 
A bit of SWAMI Trivia:  
 
There is no ‘Section 4’ in SWAMI XP2 even though it is listed on the Jump Table. That section is 
only implemented in SWAMI GenoType®, the professional version of the SWAMI system. 

Sections 
 
Each section of the SWAMI XP2 Intake Data Screen collects specific types of information about you. 
These are organized into the following groupings 
 
• About You 
• Blood Groups and Related Genes 
• Ancestral DNA Genetics 
• Your Health History 
• Gender Specifics 
• Your Family History 
• Your Laboratory Data 
• Anthropometry (Body Measurements) 
• Left Dermatoglyphics (Fingerprints) 
• Right Dermatoglyphics (Fingerprints) 
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Required Fields 
 
SWAMI XP2 will only run correctly if certain key information is provided. You can always tell if key 
information is required by the fact that the question being asked is on a yellow background and on a 
lilac background if the question is optional. Don’t fret if you forget to answer a required question; 
SWAMI XP2 will alert you to the problem and tell you exactly which question needs to be 
answered. 
 
Some entry fields require numeric (number) data. If by mistake you entry text data, SWAMI XP2 will 
alert you to the problem and tell you exactly which question needs to be given a number value. 
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Timed Fields 
 
SWAMI XP2 users will be able to refine their diets on an ongoing basis, adding data as it happens or 
they develop it. 
 
When you first begin to add information to the SWAMI Data Intake Screen, all data entry fields are 
‘unlocked’ and available for your input. Some 'unchangeable' fields, (such as your blood type, year of 
birth and gender) will 'lock' a few hours after the initial form is completed. This is to prevent 
someone from using one license to run diets on all their friends and family members. 
 
The locked field option will not start until you have supplied all the required information and tell 
SWAMI XP2 to generate a Diet Report. Rest assured, you can take your time getting your 
information together over several days and multiple sessions if needed. 
 
Having had to do that, we feel that everyone else should have the ability to further develop their 
SWAMI XP2 intake data as their bodies and/or health histories evolve. So we left a lot of the intake 
form unlocked. These unlocked parts let you continue to add additional or new data, then print out 
a fresh dietary appropriate for those new circumstances. 
 
Once you license SWAMI XP2 you can pretty much continue run as many diets on yourself as 
information, circumstances and paper supplies permit.  
 
Most locked fields contain data which would be difficult to ‘get wrong’ such as the year of your birth. 
If on the slim chance that you’ve entered the wrong data in a filed which has been time-locked, jucyt 
contact Technical Support and we’ll change the field for you. 
 
If somewhere in the future we continue to develop the software to the point of another 'major 
release' we might request folks to buy a new license, but that would be optional. 
 
Let’s take a look at each individual section of the Intake Data Form and introduce you to the logic 
behind why we’ve included it. 
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 About You 
 
This section of the SWAMI XP2 form deals with a variety of general information about yourself. 
 
 
 

 
 
 
Your Height and Weight (Required) 
 
Enter the your height in inches and weight in pounds or your height in meters and weight in kilos. 
Whichever one you choose to use, just leave the other empty. 
 
Your Ethnicity  
 
Select from the pull-down menu the possible geographic and ethnic criteria (ethnicity) that is closest 
to you. 
 
Your Year of Birth (Required, Timed)  
 
Select your year of birth from the pull-down menu. This field is time locked since we assume most 
people will enter the year of their birth correctly within the first three hours of using the program! 
 
Gender (Required, Timed) 
 
Select you gender (male, female) from the pull-down menu. 
 
Activity Multiplier (Required) 
 
Activity Multiplier is a pull-down that tells SWAMI XP2 how active you are. With BMI (‘Body Mass 
Index’) and BMR (‘Basal Metabolic Rate’) it is used to calculate the your ‘Total Daily Energy 
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Expenditure’ (TDEE). The TDEE is used to set portion sizes and frequencies and help determine 
caloric requirements. 
 
Myer-Briggs Typology (Optional) 
 
The Myer-Briggs Indicator allows you to include the Basic Myers-Briggs personality inventories in 
your GenoType calculations. An abbreviated 'quick and dirty' Myers-Briggs typology test is available 
online; the link can be accessed via the pop up help screen for this section.    
 

 
 

Serotypes and Biomarkers  
 
This section of the SWAMI XP2  intake form deals with a variety of classic genetic markers. Fields 
marked in red font color are required.  North American Pharmacal (1.203.761.0042  and 
www.4yourtype.com ) has ABO, Rh, PROP and Secretor testing kits available for purchase at 
reasonable prices. The online Help pop-up windows feature instructional videos on doing home 
blood type testing. 
 
 

 
 
Your ABO Blood Group (Required, Timed) 
 
ABO blood group is a key marker of biochemical individuality and influences every facet of 
physiology on a cellular level. It is an important influence on many digestive parameters, the chemical 
response to stress, the efficiency of the immune response. ABO blood group plays a critical role in 
embryonic development and thus is a major epigenetic and prenatal influence. Select your ABO 
blood group (A, B, AB, O) from the pull-down menu. 
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Your A1/ A2 Sub Type (Optional)  
 
A1/A2 subtype information can be added to SWAMI XP2 . This refinement applies only to individuals 
who are blood types AB or A. This distinction exerts a mild influence on aspects of protein 
selection. 
 
Your Rh Blood Group (Required, Timed)  
 
Many testing cards and the blood banks also test for The Rhesus or Rh blood type, which is common 
factor in certain types of problems between a mother and her fetus. Select your Rhesus blood group 
(Rh positive, Rh negative) from the pull-down menu. 
 
Your Secretor Status (Optional)  
 
Think of secretor status as a volume control on your ABO blood type; secretors have their blood 
type all over the place, non-secretors don’t. For example, a blood group A ‘secretor’ has their blood 
type A marker in their saliva, sweat, semen, etc. About fifteen percent of the population are ‘non-
secretors’ does not carry the gene to allow for this; their blood type is found only in some cells of 
the digestive tract and in their blood. The non-secretor state is significantly associated with celiac 
disease, metabolic conditions, including obesity, heart disease and insulin resistance and ulcers. 
Although SWAMI XP2 will run without you knowing your secretor status it is highly recommended 
that you include this data. 
 
Testing involves testing saliva for the presence or absence of blood type antigens. You can purchase 
a commercially available test, but unlike the at-home ABO test, it requires sending a saliva swab to a 
laboratory to be read. Epigenic Research can supply you with secretor kits that test for secretor 
status from saliva. 
 
Your PROP Taster Status (Required) 
 
This is a very useful and inexpensive test that checks to see if you have the gene to taste either 
phenylthiocarbamide (PTC) or a related substance called propylthiouracil (PROP). PROP outcome is 
critical to GenoType determination. There are three possible results: 
 
• ‘Non-tasters’ taste nothing from the strip 
• ‘Tasters’ can taste the bitter substance 
• ‘Super-tasters’ have an extremely strong reaction to the bitter substance 

 
You'll need to purchase two types of testing strips: a PROP-containing strip and an untreated strip, 
called a control. Use PROP testing strips rather than PTC strips. PROP strips yield the same results 
and are less toxic. A control strip is important, since people can easily imagine a taste, even if it is 
not there. PROP testing is explained in The GenoType Diet. 
 
Lewis, MN Blood Groups 
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You can include these data if you have the information. 
 
Caffeine Sensitivity and Lactose Intolerance (Required, Timed) 
 
Your responses to these questions are used to help determine your GenoType. Select from the 
options in the corresponding pull-down menus. 

 

Ancestral DNA Genetics (Optional) 
  

 
SWAMI XP2 will accept information that you may have discovered about your ‘Ancestral DNA’, 
commonly offered by such services are National Geographic’s ‘Genographic Project.’ 
 
 

 
 
https://genographic.nationalgeographic.com/ 
 
This data is in the form of particular DNA ‘haplogroups’ traceable to your ancestors.  In human 
genetics, the haplogroups most commonly studied are Y-chromosome (Y-DNA) haplogroups and 
mitochondrial DNA (mtDNA) haplogroups, both of which can be used to define genetic populations.   
Ancestral DNA haplogroups are used (when available) for GenoType determination and, to a limited 
degree, certain food selections. 
 
Y Chromosome DNA Haplogroups (Optional) 
 
Select your Y chromosome haplogroups (men only) from the pull-down menu. 
 
Mitochondrial DNA Haplogroups (Optional) 
 
Select your Mitochondrial DNA haplogroups (men and women) from the pull-down menu. 
 
For more information, Wikipedia has extensive entries on Ancestral DNA. 
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Your Health History (Optional) 
 
 
Tick the ‘Yes’ bullet for any of the health problems you have or have had. These switches drive the 
therapeutic focus of the program, a series of decisions made about specific foods after the effects of 
GenoType and blood group have been calculated.  
 

 
 
These switches also drive aspects of the GenoType determination and activate a secondary-level 
food evaluation algorithm determining susceptibility strengths conveyed by other genes and/or 
measurements. 
 

Gender Specifics (Optional) 
  

Again, tick the ‘Yes’ bullet for any of the gender specific health problems that the client has or has 
had. Light lavender boxes are for girls, purple for boys. None of these results are critical, but they 
help shape some of the SWAMI XP2  food choices. These switches help drive the therapeutic focus 
of the program and help shape the 'symmetry to gender' decisions within the program. 
 
 

 

 



SWAMI XP2 User Guide, Page 26 of 26 
 
 
 
 
Family History (Optional) 

 
Tick the ‘Yes’ bullet for any of the health problems relatives (siblings, parents and grandparents) of 
the client have or have had. None of these results are critical, but they help shape some of the 
SWAMI XP2 choices.  
 

 
 
Tick the ‘Yes’ bullet for any of the health problems family members may have or have had. These 
switches drive secondary aspects of the GenoType determination. Family history also have an effect 
on determining and amplifying susceptibility strengths conveyed by other genes and/or 
measurements. 

Anthropometry (Body Measurements)  
 
This is an important set of inputs, and if values can be supplied here, they can exert major effects on 
SWAMI XP2 food choices and GenoType determination. The online Help pop-up windows feature 
instructional videos on doing home the basic measurements. Dr. D’Adamo’s book The GenoType Diet 
also features extensive descriptions of the procedures and measurements needed.   
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The Home GenoTyping Kit (TE011) from North American Pharmacal provides the tools you'll need 
to determine your GenoType.   
 
The Kit Includes 
 

• Easy-Typing Guide 
• Biometric protractor/ruler 
• Fingerprinting Tools 
• Taster strips 

 
Handedness (Required) 
 
Like dermatoglyphic (fingerprint) patterns, handedness is more likely a reflection of outside 
disturbance during the prenatal period. 
Waist and Hip Measurements (Required) 
 
These measurements determine Waist to Hip Ratio, a general reflection of overall health. Numbers 
can be entered in either inches or centimeters. 
 
Cranial Measurements (Optional) 
 
The Cephalic Index is the ratio of the width of the head to its length. EXP2 ed as a percent number, 
it provides the simplest description of the geometric relation of two dimensions. The pop-up inline 
help has an extensive section on cranial measurements. 
 
Do You Have a Carabelli Cusp or Incisor Shoveling (Optional) 
 
Like head shape, these dental landmarks help determine long lasting effects of diet on your family’s 
epigenome (the record of epigenetic changes passed down through your family). The pop-up inline 
help has an extensive section on dental landmarks and they are also discussed in Dr. D’Adamo’s 
book The GenoType Diet 
 
What Is Your Jaw Angle (Optional) 
 
Jaw angle appear to also have some relevance to the record of epigenetic changes passed down 
through your family. The options are:  
 

• Wide (oval jaw shape) 
• Narrow (square jaw shape) 
• Neutral (a blend of both) 

 
The significance of jaw shape is also discussed in Dr. D’Adamo’s book The GenoType Diet. 
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How would you categorize your Upper Leg Space (Optional) 
 
Without pants or other confining clothing, look at the space that is created between the thighs when 
your feet are placed together and gently touching at the ankles. The options are: 
 
• Gynic (closed silhouette) 
• Andric (open silhouette) 
• Neutral (a blend of both) 
 
What is your Somatotype (Required)   
Is your Wrist Encirclement (Required) 
Is your Wrist Tendon Visibility (Optional) 
 
These body shape measurements reflect relative amounts of embryonic germ layer tissue, which is 
an important epigenetic determinant. The pop-up inline help has an extensive section on body shape 
(with instructional videos) and they are also discussed in Dr. D’Adamo’s book The GenoType Diet. 
 
What is your Trunk to Leg Ratio (Required)  
What is your Upper to Lower Leg Ratio (Required) 
 
Leg and torso ratios reflect the levels of the growth factor hormones (in particular Insulin-Like 
Growth Factors 1 and 2) that were encountered in the womb and early childhood. Insulin-like 
Growth Factors is especially significant because it’s strongly associated with growth and height. 
These are critical to GenoType determination. The pop-up inline help has an extensive section on 
leg-torso measurements (with instructional videos) and they are also discussed in Dr. D’Adamo’s 
book The GenoType Diet. 
 

Left and Right Dermatoglyphics 

 
This is an important set of inputs, and if values can be supplied here, they can exert major effects on 
SWAMI food choices.   
 
 
The Home GenoTyping Kit (TE011) from North American Pharmacal provides the tools you'll need 
to determine your GenoType.   
 
The Kit Includes 
 

• Easy-Typing Guide 
• Biometric protractor/ruler 
• Fingerprinting Tools 
• Taster strips 
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You must supply pattern data for each finger of both hands 
 

• Thumb/ D1 Ridge Pattern, both hands (Required, Timed) 
• Index/ D2 Ridge Pattern, both hands (Required, Timed)  
• Middle/ D3 Ridge Pattern, both hands (Required, Timed)  
• Ring/ D4 Ridge Pattern, both hands (Required, Timed) 
• Pinkie/ D5 Ridge Pattern, both hands (Required, Timed) 

 
 
 
The basic fingerprint pattern options that SWAMI XP2 accepts are 
 

• Arch 
• Composite 
• Radial Loop  
• Ulnar Loop 
• Tented Arch 
• Composite 

 
The pop-up inline help has an extensive section on fingerprint analysis (with instructional videos) and 
they are also discussed in Dr. D’Adamo’s book The GenoType Diet. 
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White Lines, both hands (Required) 
 
White lines are disturbances in the appearance of the fingerprint ridges such as to produce what 
appears to be white line through the fingerprint pattern. The pop-up inline help has an extensive 
section on fingerprint measures (with instructional videos) and they are also discussed in Dr. 
D’Adamo’s book The GenoType Diet. 
 
D2/ D4 Ratio: D2/ Index, both hands (Required) 
D2/ D4 Ratio: D4/ Ring, both hands (Required) 
 
The length ratio between the Index Finger (D2) and the ring finger (D4) can supply important 
information about the hormone balance you’ve experienced in early life.  D2/D4 ratios are   critical 
to GenoType determination. The pop-up inline help has an extensive section on D2/D4 measures 
(with instructional videos) and they are also discussed in Dr. D’Adamo’s book The GenoType Diet. 
 
 

Extra Options 

 
This section of the SWAMI XP2 intake form provides a variety of ways that you can prioritize and 
individualize your diet intake.  
 
This section also contains a variety of system settings that allow you to further personalize your  
Diet Report Printout.  
 

 
 
GenoHarmonic Food Clusters (Optional) 
 
This option allows you to set a preference for the generation of the GenoHarmonic food clustering. 
GenoHarmonic Foods are unique combinations of certain foods that SWAMI XP2 has determined 
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will yield the maximum epigenetic enhancement. These will show up toward the back of the diet 
report printout. The epigenetic value of the food is indicated by its star value, from exceptional (5 
stars) to very good (3 stars).  
 
 
The following choices are available: 
 
• Broad Benefit: This setting does a low level blend of all the following parameters. 
• Gene Fidelity (methylation): This setting will emphasize food combinations that enhance 

methylation reactions, typically via DNA methyltransferase or by serving as a source of methyl 
donors. Good for inflammatory conditions and anti-aging strategies 

• Gene Control (histones): This setting will emphasize food combinations that enhance histone 
deacetylase. Good for oncology management. 

• Glycation Removal (sugar): This setting will emphasize food combinations which enhance 
glycation end-product removal. Useful for metabolic syndrome, anti-aging and diabetic 
management. 

• Ubiquinylation (cell detox): This setting will emphasize food combinations which enhance 
removal of cellular debris ubiquinine pathway and the Golgi apparatus. This enhances many 
cellular functions (membrane trafficking, cell signaling, cell cycle control, X chromosome 
inactivation, and the maintenance of chromosome structure) 

 
 
Category Portion Size and Frequency (Optional) 
 
This tool allows you to adjust the portion sizes and frequencies for the food categories. The 'base' 
values are the portion sizes and frequencies listed for that GenoType in The GenoType Diet book. 
From there, portions are adjusted a bit for the gender of the client. At that point additional 
refinements can be included. 
 
• Compute Best Combination: This allows SWAMI XP2 to compute the best Frequency/Portion 

combination for the client. This is done by computing the client's BMI and Total Energy 
Expenditure (TEE) 

• More Frequent/Larger Portion: This setting is good for greatly underweight clients or clients with 
cachexia or wasting disorders. 

• Normal Frequency/Larger Portion: This setting is good for clients who are athletes or who 
otherwise need to maintain their weight. 

• Normal Frequency/Normal Portion: This is the normal setting for clients with an ideal BMI 
• Normal Frequency/Smaller Portion: This is the normal setting for clients who are marginally 

overweight, who may just need a slight bit of calorie restriction. 
• Less Frequent/Normal Portion: This is the setting for overweight clients typically interested in 

weight loss. 
• Less Frequent/Smaller Portion: This is the setting for excessively overweight or otherwise obese 

clients. 
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Special Preferences (Optional) 
 
This option allows you to superimpose some basic preferences on top of SWAMI XP2 calcualtions. 
Note that not every preference is available for every blood group. Options are: 
• Lacto-ovo Vegetarian (A B AB O) 
• Lacto Vegetarian (A AB) 
• Pescetarian (A B AB O) 
• Semi Vegetarian (A B AB O) 
• Paleolithic (B O) 
• Kosher (A B AB O) 
 
 
Special Emphasis (Optional) 
 
This option allows you select a high-level area of support. Once selected SWAMI XP2 will try to 
emphasis/deemphasize foods that contain ingredients known to influence this function. Options are: 
• Enhance Allergy Support 
• Enhance Joint Support 
• Enhance Detoxification 
• Enhance Hormonal Support 
• Enhance Nerve Support 
• Enhance Immune Support 
• Enhance Circulatory Support 
• Enhance Metabolic Support 
• Enhance Skin Support 
 
 
Supplement Recommendations (Optional) 
 
This field allows you to instruct SWAMI XP2 to recommend D'Adamo Personalized Nutrition 
supplements based up aspect of your profile: The options are:  
• Don't recommend supplements: SWAMI XP2 will skip this section of the report 
• Show top indicated products only: This will recommend only the supplements that received the 

highest ratings count. This setting is useful for filtering 'information overload' 
• Show all well indicated products: A balance of the best-indicated products. We recommend that 

you use this setting 
• Show everything indicated: Will display any products that have accumulated a minimum number 

of ratings points. This will display a lot of products! However it is often the only setting that will 
uncover more one-of-a-kind products with more specific indications. 

 
 
Supplement Detail (Optional)  
 
If you choose to have SWAMI XP2; recommend supplements, this field determines how much detail 
to render in the report:  
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• Just the Summary (Just name and key details): Use this setting if you are also requesting that 

SWAMI show all indicated products 
• Full Report (Product details and descriptions): Use this setting if you've decided that you need 

more information about the products that have been recommended 
 
 
Print Abbreviated Diet Report (Optional) 
 
You can now print a highly abbreviated diet report, only containing the title sheet, a short 
description of the category, the category food values, Genoharmonics, and the wallet card. If you 
elect to show supplement recommendations, they will also print out.  
 
Report Style (Optional) 
 
You can now print in color or grey scale.  
 
 

Nutrient Filter 
 
This subsection is may take a little getting used to, but will be well worth the study. The Food 
Nutrient Matrix is a series of switches that allow the specific nutrient content of foods to influence 
their final resting values. Although very powerful, the Nutrient FIlter is quite simple to use. As you 
can see from the illustration below: 
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Each nutrient is arrayed with two checkboxes. 
 
• Nutrients or constituents of foods which are universally deemed to be have a negative effect on 

the body have two red colored icons. 

• Checking the box next to the larger red icon ( ) will tell SWAMI GenoType to severely 
demote any food that is high in this constituent. In many instances this will in effect simply 
relegate the food to the avoid column. 

• Checking the box next to the smaller red icon ( ) will tell SWAMI GenoType to moderately 
demote any food that is high in this constituent. 

• Nutrients or constituents of foods that are universally deemed to be have a positive effect on the 
body have two green colored icons. 

• Checking the box next to the larger green icon ( ) will tell SWAMI GenoType to strongly 
promote any food that is high in this constituent. In many instances this will in effect promote the 
food to the super-food column. 

• Checking the box next to the smaller red icon ( ) will tell SWAMI GenoType to moderately 
promote any food that is high in this constituent. 

• Nutrients or constituents of foods that are may have positive or negative effects in the body 

(depending on the clinical circumstances) have both a moderate demote ( ) and a moderate 

promote ( ) checkbox. 
 
 
Although you can tick as many boxes as you desire, avoid programming more than 4-5 nutrients into 
the food matrix, since with each constituent you are increasing the chances that they will simply 
wind up cancelling each other out.  
 

 

Activate SWAMI 
 
Press the Submit button to save your SWAMI XP2 diet intake. If the form is complete you will 
then be taken to the options area, where you can print the diet report, recipes or use the 
meal planner. If the form is incomplete it will be saved and you will be alerted as to which 
fields are still in need of completion. 
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V.	  

SWAMI	  XP2	  Diet	  Report	  
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Getting Ready to Print Your Diet Report 
 
When you press the Save SWAMI XP2 Intake and Continue button from the Intake Data Screen and 
have included all the required data, you will be taken to Intake Options menu where you will have the 
following options:  
 

 
 
 

• Re-edit This Intake Form  
• Print Diet Report  
• Use Meal Planner 
• Use Recipe Generator 

 
 

 
 

 
 
Go ahead and click on ‘Print Diet Report'. After a few seconds, The Diet Report should soon appear 
on the screen. 
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Optimizing Your Diet Report 
 
The SWAMI XP2 report is already formatted and optimized for printout directly from your browser. 
From the browser’s File Menu, just select ‘Print.’ However, we should insure that your browser is 
configured to print out the SWAMI XP2 report with the best possible settings.  
 
Of these, the most important is to insure that the browser knows to print out ‘background’ colors, 
such as the green, yellow and orange columns of the food categories. SWAMI XP2  is easily readable 
in black and white, but it is much more user-friendly if printed in color. 
 

How	  to	  Insure	  that	  Background	  Colors	  Are	  Printed	  

Macintosh	  
 
Firefox	  3.x:  From the File Menu, select Print, then tick the boxes to ‘Print Background Colors’ and 
‘Print Background Images’ 
 
Safari	  3.x-‐4.x: From the File Menu, select Print, then tick the boxes to ‘Print Background Colors’ 
and ‘Print Background Images’ 

 

 
 

Print Window in Firefox for the Mac. 
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Windows	  
 
Firefox	  2.x-‐3.x:  From the File Menu, select Print, then tick the boxes to ‘Print Background Colors’ 
and ‘Print Background Images’ 
 
Internet	  Explorer	  6.x-‐7.x: From the Tools Menu, Select ‘Internet Options’, Click on the ‘Advanced’ 
tab, on the ‘Printing’ section check ‘Print Background Colors and Images’ 
 
 
 

 
 

Internet Options Window in IE for Windows 
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Setting	  Page	  Margins	  
 
Re-setting Page Margins is normally not required as most browsers default to between ½ and ¾ inch 
margins on all four sides of the page, which works fine with SWAMI XP2  
 
Internet	   Explorer	   6.x-‐7.x: From the Tools Menu, Select ‘Internet Options’, Click on the 
‘Advanced’ tab, on the ‘Printing’ section check ‘Print Background Colors and Images’ 
 

Firefox:	  
 
Re-setting Page Margins is normally not required as most Firefox browsers default to a ½ inch 
margin all around, which works fine with SWAMI XP2 .   
 
However, if you need to reset margins in Firefox, from File Menu then go to ‘Page setup.’ Then 
click on the second tab that is called ‘Margins & Header / Footer.’ From there adjust the margin 
numbers to a smaller setting 
 

Internet	  Explorer	  7:	  
 
Internet Explorer Browsers default to a ¾ inch margin all around, which usually works fine with 
SWAMI XP2 but occasionally needs to be adjusted to ½ inch. 
 
By default there's a small image of a printer in the toolbar near the top right hand side of the 
browser, click that and go to ‘Page Setup.’ You will need to choose Paper Size: Letter Borderless 
from the drop down list and then set the margins to ½ inch. 
 

Internet	  Explorer	  6:	  
 
Same as above for IE 7, except to get to the settings, go to File Menu, then ‘Page Setup’. After that 
it's exactly the same steps. 
 
 
Safari 
 
Safari normally prints out the SWAMI XP2 Diet Report just fine, but if you need to change margins, 
you will have to create a new page layout.  Here is a link that demonstrates how to do it: 
 
http://www.mintprintables.com/print-tips/adjust-margins-osx.php 
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Printing Out Your SWAMI XP2 Diet Report 
 
A typical SWAMI XP2 Diet Report is between 40 and 50 pages. The first thing you should see is the 
cover sheet. It looks like this: 
 
 

 
 

Typical SWAMI XP2 Diet Report Cover Page 
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Previewing Your SWAMI XP2 Diet Report 
 
One way to insure that your Diet Report prints correctly is to preview the printout in your 
browser. This shows how the Report will look on paper pages versus your computer screen. 
 
In virtually all browsers, you access the ‘Print Preview’ function from the ‘Print’ option from the 
browser’s File Menu. If things look acceptable, you can then print directly from the Print Preview 
screen or click ‘Close’ or ‘Cancel’ to return to the Web page. 
 

Saving Your SWAMI XP2 as an Adobe Acrobat (.PDF) File. 
 
Adobe Acrobat .PDF (portable document files) are a convenient way to save your Diet Report.  
 
Because they can be save to a flash drive, emailed or burnt to a CD, PDF files are also an excellent 
option if your printer is obsolete or only prints in black and white. You can make a copy of your diet 
report and take it to a local printer (such as Kinko’s) and for a nominal fee have them print it out for 
you. 
 
Saving a Diet Report as a printout is quite simple on the Mac, but a bit more complicated on a 
Windows computer.  
 

Macintosh	  
 
From the File Menu, select Print and from the Print Menu, click the PDF button and select ‘Save as 
PDF’ from the options. 
 
Windows	  
 
Printing to a PDF file is not natively supported on Windows computers. Many people install a 
program called ‘Acrobat Distiller’, which allows Windows users to save a file in the PDF format.  
Another option is a freeware pdf printer called BullZip: (http://www.bullzip.com/) 
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The SWAMI XP2 Diet Report in Detail 
 
Introductory and GenoType Information 
 
The first few pages of the SWAMI XP2 Diet Report contain introductory material and information 
about your GenoType determination.  There is also a short discussion about the difference between 
the Blood Type Diet and the GenoType Diet Systems. 
 
Further Customization 
 
SWAMI XP2 will usually provide information on additional steps that it has taken to further 
customize your Diet Report. These can include: 
 
Diet Emphasis 
 

• Notification that SWAMI XP2 has chosen to hybridize GenoType and Blood Type Diet 
values.  This is a powerful benefit to using a software based ‘dynamic’ approach to diet 
determination versus a ‘static’ approach normally performed with books and other forms of 
unchangeable information exchange.  

 
Emphasized and De-emphasized Nutrients 
 
SWAMI XP2 uses your intake data to supply an additional level of diet suggestions based upon your 
unique health circumstances as reflected in the data that you’ve included in your intake form. This 
often takes the form of foods that have been ‘emphasized’ or ‘de-emphasized’ based upon the 
appropriateness of the specific nutrients these foods possess. 
 
Specific foods can receive ‘moderate’ or ‘strong’ emphasis or de-emphasis, based upon a calculated 
sum of the influences the nutrients contained in these foods would exert on your health. These 
effects are applied to the foods after their blood type and GenoType values have been computed. 
‘Strong Emphasis’ might upgrade an other neutral food to ‘beneficial’ or even ‘highly beneficial.’  
Moderate de-emphasis might downgrade a temporary avoid (black dot) to permanent avoid. 
Although it is possible, it is rather uncommon for an avoid to convert to much more than a weak 
neutral despite even the strongest emphasis influences. 
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GenoHarmonic Food Clusters 
 
If you have elected to have SWAMI XP2 calculate which GenoHarmonic Function to use with your 
Diet Report, it will alert you to its conclusions here. The actual GenoHarmonic relationships are 
listed towards the end of the Diet Report.   
 
The Diet Categories 
 
After that the program prints about ten pages of introductory report information it then begins to 
output the diet. Each food category is printed separately.   
 
Each food category contains the same basic report data.  It begins by telling the client what would be 
the optimal portion sizes and weekly frequencies for that category. These portions and frequencies 
are highly specific to the client, SWAMI XP2 utilizing many of the biometric measurements to derive 
its calculations. 
 
There follows a small description that is blood type, GenoType and secretor specific and a series of 
special report notes based upon your specific parameters and priorities   
 
The second part of the food category printout is a column-by-column breakdown by value much like 
any of the blood type diet books. Let’s take a look at a typical diet category, in this case ‘Poultry’. 
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A typical SWAMI XP2 diet category. 
 
 
Food choices are broken down into a green column that includes the most beneficial foods (food as 
medicines), a yellow neutral column (food as foods) and an orange column containing foods best 
avoided (foods as toxins). In the green column, certain foods may feature a diamond-like icon, a sign 
that the food may possess extra-benefits (enhance metabolism, fight aging, etc.). In the orange 
column some foods may feature a small black dot icon. This indicates that the food may eventually 
be re-integrated into the diet, perhaps after a short (60-90) day ‘washout period.’ 
 



SWAMI XP2 User Guide, Page 46 of 46 
 
 
 
 
Categories that SWAMI XP2 will output values for will include: 
 

• Red Meats 
• Poultry 
• Fish and Seafood 
• Eggs and Roes 
• Dairy 
• Vegetable Proteins 
• Fats and Oils 
• Carbohydrates 
• Live Foods 
• Fruits 
• Spices 
• Beverages 
• Condiments 
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GenoHarmonic Foods  
 
GenoHarmonic Foods are unique combinations of certain foods which SWAMI XP2 has determined 
will yield the maximum epigenetic enhancement. The epigenetic value of the food is indicated by its 
star value, from exceptional (5 stars) to very good (3 stars). Simply reference a food you will be 
using at the left, and try to combine it with GenoHarmonic foods that are listed to the right. 
CAPITALIZED foods are Super-GenoHarmonic foods. 
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Other Features 
 
Wallet Card 
 
SWAMI XP2 will also print out a handy small version of your diet, suitable for cutting out and 
keeping in a wallet. This helps keep the food values close at hand, when shopping or dining out. 
 
Exercise 
 
SWAMI XP2 will discuss specific exercise guidelines which may help enhance metabolism and help 
you handle stress in a more resourceful way. 
 
Supplements 
 
SWAMI XP2 will discuss specific nutritional supplements that might enhance your dieting experience. 
These are purely suggestive and are optional. 
 
Glossary 
 
SWAMI XP2 will output a small glossary of terms to help you understand the core concepts behind 
the blood type diets and Dr. D’Adamo’s newest book, the GenoType Diet. 
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VI.	  

SWAMI	  XP2	  Meal	  Planner	  
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Using the SWAMI XP2 Meal Planner 

	  	  
 
When you press the Save SWAMI XP2 Intake and Continue button from the Intake Data Screen and 
have included all the required data, you will be taken to Intake Options menu where you will have the 
following options:  
 

 
 
 

• Re-edit This Intake Form  
• Print Diet Report  
• Use Meal Planner 
• Use Recipe Generator 

 
Go ahead and click on ‘Use Meal Planner'. After a few seconds, The Meal Planner interface should 
appear on the screen.  
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SWAMI XP2 Meal Planner Basics 

 
When you select ‘Go Meal Planner’ from the Print Report Screen don’t be surprised if it takes 10-15 
seconds for the screen to load. SWAMI XP2 is doing a lot of calculations! Soon enough, you will see 
the following screen: 
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Getting Around in SWAMI XP2 Meal Planner 

 
This updated software is a complete XP2 re-write of the original SWAMI Mealplanner.  
 
New Interface  
 
SWAMI Mealplanner 2.0 features a new user interface, with an intuitive 'drag and drop' selection 
method. It is divided into the basic sections. Let's begin by having a look around.  
 
Upper Bar Area 
 
The Upper Bar area looks like this:  
 

 
 
 
From left to right we see:  
 
• The SWAMI Logo 
• The Save Mealplan button: Pressing this button saves your mealplan and takes you to the 

mealplanner print-out page. 
• The Start a New Mealplan link (light bulb): Clicking on this link clears the mealplan of any tags 

that have been saved. 
• The Information/Help link (letter 'i') : Clicking on this link takes you to this help page. 
• Some information about you:  You should see your name and Genotype family here. 
 
 
Mealplanning Area 
 
The Mealplanning Area is where you construct your mealplan for the week. It looks like this:  
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You'll notice that the Mealplanning Area is designed to look like a weekly calendar. On top we have 
the rows that describe the days of the week, and along the left edge we have a column that lists the 
five types of meals you can plan for: three main meals (Breakfast, Lunch and Dinner) and two snack. 
Morning and Afternoon). You meal-plan by dragging and dropping 'meal tags' from third area (The 
Menu Area) onto the Mealplanning Area. 
 
The Menu Area 
 
The Menu Area is where you select foods and meals to add your mealplan for the week. It looks like 
this:  
 
 

 
 
The Menu area is divided into two types of 'meal tags': Recipe tags and Food tags.  
 
Recipe Tags  
 
Recipe tags comprise the first two rows of choices. This class of tags is comprised of any allowable 
recipe that does not contain any 'avoid' foods as per your SWAMI Diet Report. Recipe tags are 
classified by the major category of the recipe:  
 
• 'Appetizer' : denoted by a dark-green stripe on the left side of the tag 
• 'Baked Good' : denoted by a brown stripe on the left side of the tag 
• 'Beverages' : denoted by a purple stripe on the left side of the tag 
• 'Breakfast' : denoted by a yellow stripe on the left side of the tag 
• 'Dessert' : denoted by a dark-blue stripe on the left side of the tag 
• 'Entree' : denoted by a red stripe on the left side of the tag 
• 'Salad' : denoted by a light-green stripe on the left side of the tag 
• 'Side Dish' : denoted by a orange stripe on the left side of the tag 
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• 'Snack' : denoted by a light-blue stripe on the left side of the tag 
• 'Soups and Broths' : denoted by a pink stripe on the left side of the tag 
• 'Other' : denoted by a black stripe on the left side of the tag 
 
The background color of the Recipe tag can also alert you to the benefits of the recipe: 
 
• 'White' : the recipe contains 0-1 'highly beneficial' (diamond) ranked ingredients 
• 'Yellow' : the recipe contains 2 'highly beneficial' (diamond) ranked ingredients 
• 'Green' : the recipe contains 3 or more 'highly beneficial' (diamond) ranked ingredients 
 
 
Food Tags  
 
Food tags allow you to add individual foods and ingredients to your mealplan. These are ranked in 
accordance with your SWAMI Diet Report. Like Recipe tags, Food tags convey information based on 
the stripes and background colors: 
 
• 'Yellow background with silver stripe' : this food is a 'neutral' for you 
• 'Green background with silver stripe' : this food is a 'beneficial' for you 
• 'Green background with gold stripe' : this food is a 'highly beneficial' (super food) for you 
 
 

Making a Mealplan 
 
Constructing a mealplan is simple and intuitive. Here is an example of how to do it:  
 
Select a Recipe or Food Tag  
 
We will start with an appetizer. Using the scroll bars for the Appetizer category, we see that our 
Diet Report allows us to use the 'Broiled Lime and Soy Mushrooms' recipe, which has a green 
background, meaning that it has three or more super-food ingredients in it.  
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But we want to know a bit about the recipe before we add it to the mealplan. If we 'hover' our 
mouse over the recipe title we will see a quick description of the recipe. In this case the description 
tells us that this recipe is a 'Great appetizer or entree accompaniment.' Not much info. However if 
we click on the recipe title, a popup window will appear that shows us the recipe.  
 

 
 
 
OK, we're sold! Let's add it to the mealplan. We do this by dragging the recipe tag to the Mealplan 
Area. Move the mouse over to the left side of the tag , where the stripe is. Your mouse cursor now 
changes into the 'grab' cursor (usually a grabbing hand icon):  
 

 
 
 
Now, while holding down the left mouse button, we 'drag' the Recipe tag. Remember to drag from 
the left side of the tag, by the colored stripe. If the tag does not move around while you hold down 
the mouse button, you may have hovered over the 'name-link' area rather than the 'hover' area. We 
are going to add the 'Broiled Lime and Soy Mushroom' recipe to the 'Monday Dinner' slot. As we 
drag the tag over the menu area, the target cell will change to orange, allowing you to be certain of 
the location you will be dropping into.  
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When the orange cell for Monday-Dinner lights up, release the mouse button and magically the 
recipe is now scheduled for Monday Dinner.  
 
You build up a meal by adding any number of recipe tags and food tags to the meal slots. Dragging a 
new tag to a slot that already contains a meal tag adds the new tag to the slot.  
 

 
 

 

Special Functions 
 
 
Cloning Tags  
 
We often eat the same foods or use the same recipes on multiple days of the week. One easy way 
to reuse tags without having to find them by scrollign around the various category windows is to 
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'clone' a copy of a particular tag you need in multiples. For example, we might start each morning off 
with a cup of green tea. If we already had a tag for Green Tea in the Monday Breakfast slot we can 
simply clone this tage by holding down the SHIFT key while we grab the 'Monday Breakfast Green 
Tea tag' and dragging it to the 'Tuesday-Breakfast' slot.  
 
 

 
 
Compliance Points  
 
Dragging a tag to any active cell will activate the 'Compliance Counter.' This will count the total of 
beneficials or superfoods (diamond icon in your diet report) that have accumulated for the day. One 
(1) compliance point is awarded for any single beneficial food tag or the total of all beneficials foods 
in each recipe tag. Two (2) compliance points are awarded for each single superfood tag and for each 
superfood contained in a recipe tag. Compliance points are displayed in the compliance point row.  
 

 
 
 
Sorting Trays 
 
Sorting trays give you a convenient 'staging area' from which to design your mealplan. Dragging 
recipe and food tags from the Menu Area to one of the sorting tray areas and then cloning copies to 
use in the Mealplanning area is a quick way to build up a weekly mealplan. However, the contents of 
the sorting trays are not stored when your mealplan is saved.  
 
The Trash Bin  
 
Dragging a tag to the Trash Bin Slot (the area with a 'waste basket' icon) deletes the tag. However if 
you change you mind and want to use the tag, you can just drag another copy from the Menu Area. 
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Showing and Hiding the Menu Areas  
 
At the top of the Menu Area are two checkboxes that allow you to show or hide parts of the Menu 
Area. Turning parts of the Menu Area on or off can be a helpful way to keep the entire SWAMI 
Mealplanner work area in your browswer window. Ticking the 'Show Recipes' checkbox will display 
the Recipes section of the Menu Area and ticking the 'Show Foods' checkbox will display the Foods/ 
Ingredients section of the Menu Area. These can be combined as needed.  
 
Saving Your Mealplan 
 
Pressing the 'Save Mealplan' button will collect the information from the SWALI Mealplanner Editor, 
save it to a file, and send you to the Printout Page where you can print out the mealplan, an 
ingredients list for shopping, and whatever recipes are being used in the mealplan. Press the 'Print 
Mealplan' button to send the output to your printer. Note that saving a SWAMI mealplan always 
overwrites the previous file. 
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VII.	  

SWAMI	  XP2	  Cook	  Book	  Creator	  
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Accessing the SWAMI XP2 Cook Book Creator 
 
When you press the Save SWAMI XP2 Intake and Continue button from the Intake Data Screen and 
have included all the required data, you will be taken to Intake Options menu where you will have the 
following options:  
 

 
 
 

• Re-edit This Intake Form  
• Print Diet Report  
• Use Meal Planner 
• Use Recipe Generator 

 
 

 
 

GO ahead and click on the 'Use Recipe Generator' icon. You will then be taken to the Recipe 
Generator Screen
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Using the SWAMI XP2 Cook Book Creator 

 
The SWAMI XP2 Cook Book Creator is very easy to navigate.  
 
Once the screen appears, you will be asked to supply a preference: 
 

• Print recipes with three or more diamond beneficials (xx recipes) 
• Print recipes with two or more diamond beneficials (xx recipes) 
• Print recipes with one or more diamond beneficials (xx recipes) 
• Print 100 top-rated recipes 
• Print all permissible recipes (xx recipes) 

 
Each option will contain the number of recipes SWAMI XP2 has found which meet the criteria.  
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Pressing the 'Print Out Recipes' button will print out the recipes to the screen, from which you can 
then send to your printer for a hard copy.  Recipes will display the number of highy beneficial 
(diamond) foods in the recipe to the right of the Recipe Title. 

	  

	  

	  

	  
A note about recipe appropriateness 
 
Recipes are ‘tagged’ with major ingredients contained in the recipe. Minor ingredients may 
occasionally find their way into the recipe that may not fit exactly into your Diet Report Food 
Values. Usually this is the case of the Recipe Author using multiple options for different blood 
groups, secretor types and GenoTypes. Always double-check recipes to insure their appropriateness 
for you particular plan. 
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VIII.	  

Technical	  Support	  and	  Getting	  Help	  
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Using the SWAMI XP2 Technical Support 

	  	  
 
Perhaps it is fitting that this User manual ends where it began: At the SWAMI XP2 Support Screen. 
 
We take Customer Support very seriously and will do whatever we can to insure that you receive 
optimum value for your use of this software.  
 
However let’s discuss a few things we can’t do: 
 

• We can’t provide medical advice regarding how you should answer questions about your 
health history, family history or laboratory data  

• We can’t provide assistance with regard to techniques required to perform any of the test or 
measurements required to run the software. This information is supplied through other 
avenues, such as Dr. D’Adamo’s books, videos and instruction materials packaged with 
testing kits 

• We can’t solve problems with your computer hardware. SWAMI XP2 is designed to run on 
any modern computer that can navigate the Internet. However computers come in many 
shapes and sizes and we cannot know how fix every possible hardware mis-configuration 

 
We can try to help you: 
 

• Configure your browser correctly so as to run the program effectively and correctly print 
out the reports  

• Guide you through the interface, should aspects of the program seem daunting or confusing 
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Accessing Technical Support 
 
 
From the SWAMI Support tab, click on the lower tab for ‘Tech Support.’ 
 

 
 
 
You will be taken to the SWAMI XP2 Tech Support window. Most Tech Support can be 
accomplished via our online help system. If Tech Support is available, the screen will show that a 
Tech Support person is online and available to help you. When you click on the icon a chat window 
will open up and you can type in your question or problem.  
 
If Tech Support is not available at this time, the icon will be grayed out, and clicking on it will allow 
you to send an e-mail to Tech Support.  Response time varies with demand but we try to respond to 
all inquiries within 24 hours. 
 
You can also contact SWAMI XP2 Tech Support by phone at  
 
1.203.761.0042 
 
Monday-Friday, 9: AM-5: PM EST 
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SWAMI XP2 Support Forum 
 
 
Clicking on the SWAMI User Forums tab will take you to the SWAMI XP2 forum on the 
www.dadamo.com site.  This site gets a huge amount of traffic and there are always helpful people 
around. 
 

 

SWAMI XP2  Tips and Tricks 
 
 
This is how SWAMI GenoType® Reports are supplied to patients at the D’Adamo Clinic. Thiscan be 
used for your SWAMI XP2 material as well. 
 

• Purchase ½ inch plastic binders that have clear plastic cover slips on front 
• Purchase three-whole punched paper 
• Purchase three whole dividers 
• Print out the report 
• Insert front page into binder front cover slip 
• Place rest of printout in binder 
• Insert one divider at beginning of food categories 
• Insert one divider at beginning of the GenoHarmonic Pages 
• Insert one divider at beginning of the Supplement Pages 

 
You can also use the same treatment for the recipe printout 
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